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Understanding and
Controlling Results

To create accurate linearized models, it is important to be able to interpret
the results and to understand the linearization algorithms. One method of
interpreting the results is by simulating the linearized model and comparing
the output with the original model. The linearization algorithms can be
adjusted in various ways to control these results, as outlined in this chapter.

“Comparing the Linearized and
Original Models” (p. 1-2)

Methods for simulating the
linearized model and comparing the
results to the original model.

“Linearization Algorithms” (p. 1-9) Brief introduction to the two
main linearization methods with
advantages and disadvantages of
each

“Block-by-Block Analytic
Linearization” (p. 1-11)

Description of the default
linearization method with
suggestions for controlling the
results.

“Numerical-Perturbation
Linearization” (p. 1-27)

Description of an alternative
linearization method with
suggestions for controlling the
results.

“Recommendations for Creating
Accurate Linearized Models”
(p. 1-32)

Description of what it means to
linearize a Simulink® model and how
to use correct modeling techniques



1 Understanding and Controlling Results

Comparing the Linearized and Original Models
Comparing simulations of the original model with simulations of the
linearized model helps to determine if the linearized system behaves in a
similar way to the original model. To make this comparison, re-insert the
linearized subsystem into the model, configure the inputs and operating
points so that they are the same as in the original model, and then compare
output signals from a simulation of the two models.

When comparing models, remember that the states, inputs, and outputs of the
linearized model are defined about an operating point of the original model,
using the following variables:

This means that when the original model is at the operating point x(t)=x0,
u(t)=u0, y(t)=y0, the linearized model will be at the operating point δx(t)=0,
δu(t)=0, δy(t)=0. To compare the models accurately, subtract u0 from input
values and x0 from the initial state values in the linearized model, then add y0
to the output signal.

When you linearize only a portion of the original model, you should simulate
the linearized model by substituting it back into the model in place of the
original portion. This ensures that the operating point and inputs to the
linearized portion are correct. To do this, export the linearized model to the
workspace, delete the original portion from the model, and replace it with an
LTI System block based on the linearized model.

Example
This example compares the magball model with the linearized model
computed in "Linearizing the Model":

1 If you have not done so already, linearize the magball model at the
targeted operating point computed in "Computing Operating Points from
Specifications".
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Comparing the Linearized and Original Models

2 To create a new model containing the linearized plant system, first export
the linearized model and operating point from the Control and Estimation
Tools Manager to the MATLAB® workspace. To do this, right click the
linearized model name in the project tree of the Control and Estimation
Tools Manager. Select Export from the menu. Accept the default name for
the model, Model_sys, and for the operating point, Model_op.

Then, create a new Simulink® model, magball_lin, which is a copy of the
original model, magball. Replace the Magnetic Ball Plant subsystem in
magball_lin with an LTI System block (located in the Control System
Toolbox category of the Simulink Library Browser). Import the linearized
model into this block by entering Model_sys in the LTI system variable
field in the Block Parameters window.

3 Set the operating points of the models by specifying the initial values of the
states in the models:

a To set the initial values for magball, first enter the following at the
command line

[x,u]=getxu(Model_op)

This returns vectors of state values and input values from the object
Model_op.

x =
0.0500
0
-0.0000
7.0036
0

u =
[]

The ordering of states in these vectors is the same as that used in the
Simulink model. To use the values in the state vector, x, as initial values
for the model, select Simulation -> Configuration Parameters in the
magball model window, then select the Data Import/Export panel.
Select the check box next to Initial State and enter x on the right. Click
OK.
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1 Understanding and Controlling Results

b In magball_lin, the operating point values for the linearized system will
all be zero since this subsystem was linearized about the operating point
values. The operating point values in the Controller will be the same as
in the original model since the Controller was not linearized. To create a
vector of initial state values with the correct state ordering, first create a
new operating point object for the system by typing

op=operpoint('magball_lin')
Change the operating point for the Controller in op to be the same as
those in Model_op.

op.States(1).x=Model_op.States(1).x
This returns the following operating point.

Operating Point for the Model magball_lin.
(Time-Varying Components Evaluated at time t=0)

States:
----------
(1.) magball_lin/Controller/Controller

x: 0
x: -2.56e-006

(2.) magball_lin/LTI System/Internal
x: 0
x: 0
x: 0

Inputs: None
Keep the operating point for the LTI system as zero. Extract vectors of
states and inputs from this edited operating point.

[x1,u1]=getxu(op)
which returns

x1 =
1.0e-005 *

0
0
0
0

-0.2556
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Comparing the Linearized and Original Models

u1 =
[]

c To use the values in the state vector, x1, as initial values for magball_lin,
select Simulation -> Configuration Parameters in the magball_lin
model window, then select the Data I/O panel. Select the check box next
to Initial State and enter x1 on the right. Click OK

4 The output of magball_lin will be zero at the operating point. To create
an output signal that is comparable with that in magball, add a Constant
block, with a value of 0.05 to the output of magball_lin. Similarly, the
input to magball_lin should be zero at the operating point. This is
achieved by subtracting a value of 14 from the input signal of the linearized
system. The operating point values, 0.05 and 14, were found using a Scope
block to measure steady-state signal levels in the original model.

5 To observe the response of the models to a perturbation, add a Step block
with the following parameter values to the input to the plant in both
models.
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1 Understanding and Controlling Results

Parameter Values for Step Block

The model diagrams should now look like those in the following figures.
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Magball Model with a Step Block Added to the Input

Magball Model with Linearized Magnetic Ball Plant

6 Run simulations in both models. The output signals, in the Scope blocks,
are shown in the following figure.
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Scope Blocks from Original (left) and Linearized (right) Models

As shown in the figure, both the original and linearized models react to the
step input in a similar way.
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Linearization Algorithms

Linearization Algorithms
Simulink Control Design can use two different linearization methods.
The default method, which is used unless an option is selected, is called
block-by-block analytic linearization. To use the alternative method,
numerical-perturbation linearization, you must select an option in the
Linearization Options dialog box of the GUI, or if using functions, with
the linoptions function. The remainder of this chapter describes the two
linearization methods in more detail and provides suggestions for controlling
the results to create more accurate linearized models.

The default linearization method, block-by-block analytic linearization,
linearizes the blocks individually and then combines the results to produce
the linearization of the whole system. This method has several advantages:

• It divides the linearization problem into several smaller, easier problems.

• It defines the system being linearized by input and output markers on the
signal lines rather than root-level inport and outport blocks.

• It supports open loop analysis.

• You can control the linearization of each block by using an analytic
linearization that is programmed into the block or by selecting a
perturbation level for the block.

The main disadvantage of this method is that for large or complicated systems
it might be slower than numerical-perturbation linearization.

Alternatively, numerical-perturbation linearization linearizes the whole
system by numerically perturbing the system’s inputs and states about the
operating point. This method has the advantage that it is quick and simple,
especially for large or complicated systems. However, there are also several
disadvantages with this method:

• It relies on root-level inport and outport blocks to define the system being
linearized.

• There is no support for open loop analysis.

• You have limited control over the perturbation levels for each block.

• It does not use any of the analytic, pre-programmed block linearizations.
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1 Understanding and Controlling Results

• It is sensitive to scaling issues (models with large and small signal values).

“Block-by-Block Analytic Linearization” on page 1-11 and
“Numerical-Perturbation Linearization” on page 1-27 discuss these methods
further.
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Block-by-Block Analytic Linearization
Block-by-block analytic linearization is the default linearization method
in Simulink Control Design. In this method, each of the blocks within
the linearization path is first linearized individually. The linearization of
the whole system is then computed by combining these results using the
algorithm discussed in . This approach breaks the problem into several
smaller problems. The following section gives details of the methods used to
linearize each block, with suggestions for controlling the linearizations to
create more accurate linearized models.

Individual Block Linearization Methods
There are two methods that Simulink Control Design uses to linearize the
individual blocks in a model. Each method has options that you can control to
create accurate linearized models.

Analytic Linearization
Many Simulink blocks contain analytic Jacobians for exact linearization.
When linearizing a system using block-by-block analytic linearization, you
can use these analytic linearizations instead of numerically perturbing the
block. This is especially useful for blocks that contain discontinuities and do
not give good results using numerical perturbation.

The following table lists the Simulink blocks that contain analytic Jacobians
for linearization. For more information see the reference page for each block.

Analytic Block Jacobians

Block Analytic
Jacobian
(Y/N)

Notes

Continuous Library

Derivative Y Allows control of the time constant
for the filter constant
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Analytic Block Jacobians (Continued)

Block Analytic
Jacobian
(Y/N)

Notes

Integrator Y OIncludes option to exclude
saturation and resets from
linearization

State-Space Y

Transfer Fcn Y

Transport Delay Y Allows control of Padé order

Variable Transport
Delay

Y Allows control of Padé order

Zero-Pole Y

Discontinuities Library

Backlash N

Coulomb and Viscous
Friction

N

Dead Zone Y Includes option to treat as gain when
linearizing

Dead Zone Dynamic Y

Hit Crossing N

Quantizer Y Includes option to treat as gain when
linearizing

Rate Limiter Y Includes option to treat as gain when
linearizing

Rate Limiter Dynamic N

Relay N

Saturation Y Includes option to treat as gain when
linearizing

Saturation Dynamic N
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Analytic Block Jacobians (Continued)

Block Analytic
Jacobian
(Y/N)

Notes

Wrap to Zero N

Discrete Library

Difference Y

Discrete Derivative N

Discrete Filter Y

Discrete State-Space Y

Discrete Transfer Fcn Y

Discrete Zero-Pole Y

Discrete-Time
Integrator

Y Includes option to ignore saturation
and resets during linearization.
Jacobian not supported for
non-double data types.

First-Order Hold N

Integer Delay N

Memory Y Linearizes to a gain of 1

Tapped Delay N

Transfer Fcn First
Order

Y

Transfer Fcn Lead or
Lag

Y

Transfer Fcn Real Zero Y

Unit Delay Y Jacobian does not support
frame-based signals

Weighted Moving
Average

N

Zero-Order Hold N
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Analytic Block Jacobians (Continued)

Block Analytic
Jacobian
(Y/N)

Notes

Logic and Bit Operations Library

Bit Clear N

Bit Set N

Bitwise Operator N

Combinatorial Logic N

Compare To Constant N

Compare To Zero N

Detect Change N

Detect Decrease N

Detect Fall Negative N

Detect Fall
Nonpositive

N

Detect Increase N

Detect Rise
Nonnegative

N

Detect Rise Positive N

Extract Bits Y

Interval Test N

Interval Test Dynamic N

Logical Operator N

Relational Operator N

Shift Arithmetic N

Lookup Tables Library
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Analytic Block Jacobians (Continued)

Block Analytic
Jacobian
(Y/N)

Notes

Cosine N

Direct Lookup Table
(n-D)

N

Interpolation (n-D)
using PreLookup

Y

Lookup Table N

Lookup Table (2-D) N

Lookup Table (n-D) N

Lookup Table Dynamic N

PreLookup Index
Search

Y

Sine N

Math Operations Library

Abs Y

Add Y

Algebraic Constraint N

Assignment N

Bias Y

Complex to
Magnitude-Angle

N

Complex to Real-Imag N

Divide Y

Dot Product N

Gain Y
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Analytic Block Jacobians (Continued)

Block Analytic
Jacobian
(Y/N)

Notes

Magnitude-Angle to
Complex

N

Math Function N

Matrix Concatenation N

MinMax N

MinMax Running
Resettable

N

Polynomial N

Product Y

Product of Elements Y

Real-Imag to Complex N

Reshape N

Rounding Function N

Sign Y Linearizes to Inf at zero, linearizes
to zero otherwise

Sine Wave Function N

Slider Gain Y

Subtract Y

Sum Y

Sum of Elements Y

Trigonometric
Function

N

Unary Minus N

Weighted Sample Time
Math

N
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Analytic Block Jacobians (Continued)

Block Analytic
Jacobian
(Y/N)

Notes

Model Verification Library

Assertion N/A Does not contain outputs

Check Discrete
Gradient

N/A Does not contain outputs

Check Dynamic Gap N/A Does not contain outputs

Check Dynamic Lower
Bound

N/A Does not contain outputs

Check Dynamic Range N/A Does not contain outputs

Check Dynamic Upper
Bound

N/A Does not contain outputs

Check Input
Resolution

N/A Does not contain outputs

Check Static Gap N/A Does not contain outputs

Check Static Lower
Bound

N/A Does not contain outputs

Check Static Range N/A Does not contain outputs

Check Static Upper
Bound

N/A Does not contain outputs

Model Wide Utilities Library

Block Support Table N/A Does not contain outputs

DocBlock N/A Does not contain outputs

Model Info N/A Does not contain outputs

Time-Based
Linearization

N/A Does not contain outputs

Trigger-Based
Linearization

N/A Does not contain outputs
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Analytic Block Jacobians (Continued)

Block Analytic
Jacobian
(Y/N)

Notes

Ports and Subsystems Library

Configurable
Subsystem

N/A Only the blocks within the subsystem
are part of the linearization

Atomic Subsystem N/A Only the blocks within the subsystem
are part of the linearization

CodeReuse Subsystem N/A Only the blocks within the subsystem
are part of the linearization

Enable N

Enabled and Triggered
Subsystem

N/A Only the blocks within the subsystem
are part of the linearization

Enabled Subsystem N/A Only the blocks within the subsystem
are part of the linearization

For Iterator Subsystem N/A Only the blocks within the subsystem
are part of the linearization

Function-Call
Generator

N/A Only the blocks within the subsystem
are part of the linearization

Function-Call
Subsystem

N/A Only the blocks within the subsystem
are part of the linearization

If N

If Action Subsystem N/A Only the blocks within the subsystem
are part of the linearization

Inport N/A Does not contain outputs

Model N

Outport N/A Does not contain inputs

Subsystem N/A Only the blocks within the subsystem
are part of the linearization
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Analytic Block Jacobians (Continued)

Block Analytic
Jacobian
(Y/N)

Notes

Switch Case N

Switch Case Action
Subsystem

N/A Only the blocks within the subsystem
are part of the linearization

Trigger N

Triggered Subsystem N/A Only the blocks within the subsystem
are part of the linearization

While Iterator
Subsystem

N/A Only the blocks within the subsystem
are part of the linearization

Signal Attributes Library

Data Type Conversion Y

Data Type Conversion
Inherited

Y

Data Type Duplicate N/A Does not contain outputs

Data Type Propagation N/A Does not contain outputs

Data Type Scaling
Strip

Y

IC N

Probe N

Rate Transition Y

Signal Conversion Y

Signal Specification Y

Weighted Sample Time N

Width N

Signal Routing Library

Bus Assignment Y
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Analytic Block Jacobians (Continued)

Block Analytic
Jacobian
(Y/N)

Notes

Bus Creator Y

Bus Selector Y

Data Store Memory N/A Does not contain inputs or outputs

Data Store Read Y Linearizes to a gain of 1. Assumes
that there is no delay between data
store read and data store write.

Data Store Write Y Linearizes to a gain of 1. Assumes
that there is no delay between data
store read and data store write.

Demux N/A

Environment
Controller

Y

From N/A

Goto N/A

Goto Tag Visibility N/A

Index Vector Y

Manual Switch Y

Merge N

Multiport Switch Y

Mux N/A

Selector Y

Switch Y

Sources Library - N/A No Inputs

Sinks Library - N/A No Outputs

User Defined Functions Library
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Analytic Block Jacobians (Continued)

Block Analytic
Jacobian
(Y/N)

Notes

Embedded MATLAB
Function

N

Fcn N

Level-2 M-File
S-Function

N

MATLAB Fcn N

S-Function N

S-Function Builder N

Additional Math and Discrete Library

Fixed-Point
State-Space

Y

Transfer Fcn Direct
Form II

N

Transfer Fcn Direct
Form II Time Varying

N

Unit Delay Enabled Y

Unit Delay Enabled
External IC

Y

Unit Delay Enabled
Resettable

Y

Unit Delay Enabled
Resettable External IC

Y

Unit Delay External IC Y

Unit Delay Resettable Y

Unit Delay Resettable
External IC

Y
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Analytic Block Jacobians (Continued)

Block Analytic
Jacobian
(Y/N)

Notes

Unit Delay With
Preview Enabled

Y

Unit Delay With
Preview Enabled
Resettable

Y

Unit Delay With
Preview Enabled
Resettable External
RV

Y

Unit Delay With
Preview Resettable

Y

Unit Delay With
Preview Resettable
External RV

Y

Decrement Real World Y

Decrement Stored
Integer

Y

Decrement Time To
Zero

Y

Decrement To Zero Y

Increment Real World Y

Increment Stored
Integer

Y

Several of these blocks include options to control the linearization that you
can adjust in the Block Parameters window. For example, you can change the
order of the Padé approximation used in the Transport Delay block or select
the Treat as gain when linearizing option in the Saturation block. The
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Notes column of the table above gives details on blocks that include these
options.

Note The preprogrammed, analytic block linearizations are only used in
block-by-block analytic linearization. When using numerical-perturbation
linearization, these blocks will be numerically perturbed along with the rest
of the system.

Block Perturbation
When a preprogrammed block linearization cannot be used, Simulink Control
Design will compute the block linearization by numerically perturbing the
states and inputs of the block about the operating point of the block. As
opposed to the numerical-perturbation linearization method, this perturbation
is local and its propagation through the rest of the model is restricted.

The block perturbation algorithm involves introducing a small perturbation to
the nonlinear block and measuring the response to this perturbation. Both
the perturbation and the response are used to create the matrices in the linear
state-space model of this block. Changing the size of the perturbations will
change the resulting linearized model.

As described in "Linearization of Nonlinear Models", a nonlinear Simulink
block can be written as a state-space system:

In these equations, x(t) represents the states of the block, u(t) represents the
inputs of the block, and y(t) represents the outputs of the block.

A linearized model of this system is valid in a small region around the
operating point t=t0, x(t0)=x0, u(t0)=u0, and y(t0)=g(x0,u0,t0)=y0. Subtracting the
operating point values from the states, inputs, and outputs defines a set of
variables centered about the operating point:
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The linearized model can be written in terms of these new variables and is
usually valid when these variables are small, i.e. when the departure from
the operating point is small:

The state-space matrices A, B, C, and D of this linearized model represent
the Jacobians of the block, as defined in "Linearization of Nonlinear Models".
To compute the matrices, the states and inputs are perturbed, one at a time,
and the response of the system to this perturbation is measured by computing

and δy. The perturbation and response are then used to compute the
matrices in the following way

A i
x x

x x
B i

x x

u u

C i
y

x o

p i o

u o

p i o

x

p i p i(:, ) , (:, )

(:, )

, ,

, ,
=

−

−
=

−

−

=
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pp i p i
y

x x
D i

y y

u u

o

p i o

u o

p i o

, ,

, ,
, (:, )

−

−
=

−

−

where

• xp,i is the state vector whose ith component is perturbed from the operating
point value.

• xo is the state vector at the operating point.

• up,i is the input vector whose ith component is perturbed from the operating
point value.

• uo is the input vector at the operating point.

• is the value of at xp,i, uo.
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• is the value of at up,i, xo.

• is the value of at the operating point.

• is the value of at xp,i, uo.

• is the value of at up,i, xo.

• yo is the value of y at the operating point.

Linearized models of discrete-time or multi-rate blocks are computed in a
similar way. See "Linearization of Discrete-Time Models" and "Linearization
of Multi-Rate Models" for the equations of linearized discrete-time and
multi-rate systems.

Note A perturbed value is one that has been changed by a very small amount
from the operating point value. The default difference between the perturbed

value and the operating point value is for block-by-block
analytic linearization, where x is the operating point value.

Changing the size of the perturbations will change the linearization results.

The default perturbation size is where x is the operating point
value of the state or input being perturbed. To change the perturbation
size of the states in the Magnetic Ball Plant block in the magball model to

, type

blockname='magball/Magnetic Ball Plant'
set_param(blockname,'StatePerturbationForJacobian','1e-7')

To change the perturbation size of the input of the Magnetic Ball Plant block

to , where u is the input signal level, follow these steps:

1 Get the block’s port handles
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ph=get_param('magball/Magnetic Ball Plant','PortHandles')

2 Get the inport

pin=ph.Inport(1)

3 Set the perturbation level for this inport

set_param(pin,'PerturbationForJacobian','1e-7')

If there is more than one inport, you can choose to assign a different
perturbation level to each. The following figure shows an S-Function block
with two input signals, the actual signal and an index variable. Since
you probably do not want to perturb the index signal, you can assign a
perturbation level of zero to this inport.

��������	�
��
���


����

Block Containing Two Inports
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Numerical-Perturbation Linearization
An alternative linearization method available for use in Simulink Control
Design is numerical-perturbation linearization, which computes state-space
matrices for the linearized model by numerical perturbation of the whole
system. The method is relatively quick and simple, although as mentioned in
“Linearization Algorithms” on page 1-9, it does have some disadvantages.

Numerical-perturbation linearization requires that root-level inport and
outport blocks be present in the model. These blocks define the portion of the
model that you want to linearize instead of inserting input and output points
by right-clicking on the signal lines. Any input, output, or open loop points on
signal lines in the model will be ignored when using numerical-perturbation
linearization.

The perturbation is introduced to the system at the root level inport
blocks and in the states of the system. The response to the perturbation is
measured at the outport blocks.Suggestions for controlling the results of
numerical-perturbation linearization to create accurate linearized models are
given in “Controlling the Results of Numerical-Perturbation Linearization”
on page 1-30

Invoking Numerical-Perturbation Linearization
Prior to Simulink 3.0, numerical-perturbation linearization was the only
linearization method available with Simulink. Although block-by-block
analytic linearization is now the default linearization method, you might
choose to use numerical-perturbation linearization if your model is very
large or complicated.

To use numerical-perturbation linearization with the Simulink Control Design
GUI, select Tools -> Options while in the Linearization Task node of the
Control and Estimation Tools Manager and select Numerical-Perturbation
from the Linearization Algorithms menu.

To use numerical-perturbation linearization with the linearize function,
set the LinearizationAlgorithm option to 'numericalpert' with the
linoptions function.

linopt=linoptions('LinearizationAlgorithm','numericalpert')
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1 Understanding and Controlling Results

To linearize the model, type

sys=linearize('modelname',op,linopt)

where modelname is the name of the model being linearized and op is the
operating point object for the system.

Perturbation Algorithm
The numerical perturbation algorithm involves introducing a small
perturbation to the nonlinear model and measuring the response to this
perturbation. Both the perturbation and the response are used to create
the matrices in the linear state-space model. Changing the size of the
perturbations will change the resulting linearized model.

As described in "Linearization of Nonlinear Models", a nonlinear Simulink
model can be written as a state-space system:

In these equations, x(t) represents the states of the model, u(t) represents the
inputs of the model, and y(t) represents the outputs of the model.

A linearized model of this system is valid in a small region around the
operating point t=t0, x(t0)=x0, u(t0)=u0, and y(t0)=g(x0,u0,t0)=y0. Subtracting the
operating point values from the states, inputs, and outputs defines a set of
variables centered about the operating point:

The linearized model can be written in terms of these new variables and is
usually valid when these variables are small, i.e. when the departure from
the operating point is small:
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The state-space matrices A, B, C, and D of this linearized model represent the
Jacobians of the system, as defined in "Linearization of Nonlinear Models".
To compute the matrices, the states and inputs are perturbed, one at a time,
and the response of the system to this perturbation is measured by computing

and δy. The perturbation and response are then used to compute the
matrices in the following way
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where

• xp,i is the state vector whose ith component is perturbed from the operating
point value.

• xo is the state vector at the operating point.

• up,i is the input vector whose ith component is perturbed from the operating
point value.

• uo is the input vector at the operating point.

• is the value of at xp,i, uo.

• is the value of at up,i, xo.

• is the value of at the operating point.

• is the value of at xp,i, uo.
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• is the value of at up,i, xo.

• yo is the value of y at the operating point.

Linearized models of discrete-time or multi-rate systems are computed in a
similar way. See "Linearization of Discrete-Time Models" and "Linearization
of Multi-Rate Models" for the equations of linearized discrete-time and
multi-rate systems.

Note A perturbed value is one that has been changed by a very small
amount from the operating point value. The default difference between

the perturbed value and the operating point value is for
numerical-perturbation linearization.

Controlling the Results of Numerical-Perturbation
Linearization
Several factors influence the creation of accurate linearized models. "What
Is Linearization?" discusses some of these factors, such as careful selection
of operating points. Factors that are particular to numerical-perturbation
linearization are presented here, with suggestions for controlling them.

Setting the Perturbation Level
In numerical-perturbation linearization, there are three options for setting
the perturbation levels of states and inport blocks:

1 You can accept the default perturbation levels. The default perturbation

levels for the states are , where x is a vector of the operating
point values for the states in the model. Similarly, default perturbation

levels for the inport blocks are , where u is a vector of the
operating point values for the inputs in the model.

2 You can edit the linearization property NumericalPertRel using the
linoptions function. The value of this property adjusts the perturbations
in the following way:
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• The perturbation of the states is

.

• The perturbation of the inputs is
.

3 You can provide vectors of perturbation levels for the states and
inport blocks. These values override the values computed using the
NumericalPertRel value. Specify the perturbation levels by editing the
linearization properties NumericalXPert and NumericalUPert using the
linoptions function. The properties NumericalXPert and NumericalUPert
are vectors of absolute perturbation levels.

Handling Special Blocks
Certain blocks, especially those containing discontinuities such as Saturation
or Transport Delay, may not linearize well using numerical-perturbation.
Although these blocks often have preprogrammed linearizations that are
used with block-by-block analytic linearization instead of numerically
perturbing them, they are not used in numerical-perturbation linearization.
An alternative solution is to replace these blocks with an appropriate block
before linearizing your model. For example, you might choose to replace a
Saturation block with a Gain block.

Handling Feedback Loops
"Understanding Open Loop Analysis" discusses the effect of feedback loops
on the results of a linearization. With block-by-block analytic linearization,
you can perform open loop analysis without removing feedback loops. When
using numerical-perturbation linearization, the only way to remove the effect
of feedback loops is to manually remove them from the model and manually
force the operating point to remain the same as the original model.
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Recommendations for Creating Accurate Linearized
Models

Particular blocks and modeling situations in Simulink can sometimes cause
linearization difficulties. However, by understanding what it means to
linearize a Simulink model and by using the correct modeling techniques, you
can create accurate linearized models for use in further analysis and design.

This section consists of examples that highlight modeling situations that can
lead to problems when computing linearized models, with recommendations
for ways to avoid these situations. The examples focus on the following
modeling situations:

• “Blocks with Discontinuities” on page 1-32

• “Non-Double Data Types” on page 1-33

Blocks with Discontinuities
There are several Simulink blocks that contain discontinuities, such as the
Sign block, whose behavior is shown in the following figure.

The very large derivatives that occur at the point of discontinuity can cause
problems with linearization. For example, the Sign block has the following
linearization
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where D is a state-space matrix, and u is the input signal to the block.

When these blocks are within the linearization path of your model, the
resulting linearized model could potentially have very large values. There is
no obvious solution to this problem and it is recommended that you remove or
replace these blocks. However, when your model operates in a region away
from the point of discontinuity, the linearization will be zero. This should not
cause any problems, although when the linearizations of several blocks are
multiplied together (as in a feedback path) it can cause the linearization of
the system to be zero.

When these blocks are outside the linearization path, they can still
contribute to the definition of the operating point of the model but will not
otherwise affect the linearization. It is safe to use them for reference signals,
disturbances, and any other signals and blocks that are not being linearized.

Other examples of blocks with discontinuities include

• Relational Operator blocks

• Relay block

• Logical Operator blocks

• Stateflow blocks

• Quantizer block (has an option to treat as a gain when linearizing)

• Saturation block (has an option to treat as a gain when linearizing)

• Deadzone block (has an option to treat as a gain when linearizing)

Non-Double Data Types
Blocks that have non-double data type signals as either inputs or outputs, and
which do not have a preprogrammed exact linearization, will automatically
linearize to zero as they cannot be numerically perturbed. For example, many
logical operator blocks have Boolean outputs and will therefore linearize to
zero.
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1 Understanding and Controlling Results

To work around this problem, you can use a Data Type Conversion block,
which does have a preprogrammed exact linearization, to convert your signals
to doubles before linearizing the model. The following example illustrates this
concept. The model in this example is configured to linearize the Square block
at an operating point where the input is 1. The resulting linearized model
should be 2 but the input to the Square block is Boolean and the linearization
is zero.

However, by inserting a Data Type Conversion block before the linearization
input point, the input signal to the Square block is a double, and the linearized
model gives the correct response of 2.
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Overriding Non-Double Data Types
When linearizing a model that contains non-double data types but still runs
correctly in all double precision, you can choose to override all data types
with doubles. To do this, in the model window select Tools —> Fixed-Point
Settings from the menu. This opens the Fixed-Point Settings window.
Within this window select True doubles from the Data type override
menu. When linearizing and simulating the model, it now uses doubles for
all data types.

Note This method does not work when the model relies on other data types
in its algorithm, such as relying on integer data types to perform truncation
from floats.
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